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Introduction

The TMD3719 evaluation kit comes with everything needed to evaluate the TMD3719. The device
features proximity detection and digital ambient light sensing (ALS).

Kit Contents

Figure 1:
Evaluation Kit Contents

No. Iltem Description

1 TMD3719 Daughter Card PCB with TMD3719 sensor installed

2 EVM Controller Board Used to communicate USB to 12C

3 USB Cable (A to Mini-B) Connects EVM controller to PC

4 Flash Drive Include application installer and documents

Ordering Information

Ordering Code Description

TMD3719 EVM TMD3719 ALS/Color and Proximity Sensor
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2 Getting Started

The software should be installed prior to connecting any hardware to the computer. Follow the
instructions found in the Quick Start Guide (QSG). This loads the required driver for the USB interface
and the device’s graphical user interface (GUI).

The balance of this document identifies and describes the controls available on the GUI. In
combination with the TMD3719 datasheet, the QSG and application notes available on the ams
website, www.ams.com, there should be enough information to allow evaluation of the TMD3719
device.
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3 Hardware Description

The hardware consists of the EVM Controller, the TMD3719 EVM daughter card, and a USB interface
cable. The EVM controller board provides power and I2C communication to the daughter card through
a seven-pin connector. When the EVM controller is connected to the PC through USB, a green LED
on the board flashes once on power up to indicate the system is getting power.

For schematics, layout and BOM information please see the documents included with the install
located in the TMD3719 EVM folder (All Programs -> ams -> TMD3719 EVM -> Documents).

Figure 2:
Evaluation Kit Hardware
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4 Software Description

The main window (Figure 3) contains the system menus, system level controls, device information and
logging status. The ALS tab contains controls for the light sensing function. The Prox tab contains
settings for the proximity function. The Flicker tab contains controls for flicker detection. The
application polls the ALS and proximity raw data as well as flicker data continuously and displays them
on the GUI.

Figure 3:
GUI Main Window

[61 TMD3719v1.0.0 - TMD3719 = m] X
File Log Help
Enable ALS  Prox  Ficker
Power Gain Mean Stdev
M Prox [J Common Clear 0: 4544 4546 4
2 aLs AGC Red 1 259 2597 3
Greed 2 1464 1465 2
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[ Ficker a X Blue 3 800 800 0
JAGAINT: |2 v Leak 4 56 56 0
e O rcan2 EES Wide 5 292 2294 2
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[J AGAING: | v
[JAGAINT7: | v
ATIME: 35 4| 100ms
Osc Cal ASTEP: (1023 13| 2778ms
Mode: |disable WTIME: 0 [3] off
Veynch: [16[2] 60Hz Wt [of 5
175 350
EVM ID: 249734692212 [ Disable Poling Comments | I |
D: 0x40, Rev: x13, Aux: 0x03 100 |2 ms Count Elapsed Tme ¥ of samples
Poling Interval = 115ms 0 0 2000 |
4.1 Connect Software to Hardware

On startup, the software automatically connects to the hardware. On successful initialization, the
software displays a main window, containing controls pertinent to the connected device. If the software
detects an error, an error window appears. If “Device not found or is unsupported” appears, verify the
correct daughterboard is properly connected to the EVM controller board. If “Cannot connect to EVM
board” appears, verify the USB cable is connected. When the EVM controller board is connected to
the USB, a green LED on the board flashes once on power up to indicate the USB cable is connected
and providing power to the system.

If the EVM board disconnects from the USB bus while the program is running, it displays an error
message and then terminates. Reconnect the EVM board and restart the program.
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4.2 System Menus

At the top of the window there are pull-down menus labeled “File”, “Log”, and “Help”. The File menu
provides basic application-level control. The Log menu controls the logging function, and the Help
menu provides version and copyright information for the application.

42.1 File Menu

The File menu contains the following functions:

Figure 4:
File Menu

[ File

Reread Registers
Exit

The Reread Registers function forces the program to re-read all of the control registers from the
device and display them on the screen. This does not read the output data, because the program
reads those registers continually while it is running.

Click on the Exit command to close the main window and terminate the application. Any unsaved log
data is cleared from memory. The application can also be closed by clicking the red “X” in the upper
right hand corner.

4.2.2 Log Menu

The Log menu controls the logging function and saves the log data to a file. Log data accumulates in
memory until discarded or written to a data file.

Figure 5:
Log Menu

Log

Start Logging
Stop Logging
Lzg a Single Entry

Clear Leg

Save Log

Click Start Logging to start the logging function. Each time the program polls the output information
from the device, it creates a new log entry showing the raw data values, the values of various control
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registers, and the values entered by the user into the text fields near the bottom right corner of the
window.

Click Stop Logging to stop the logging function. Once logging stops, the user may store the data in a
file, or continue collecting additional data by clicking Start Logging again.

The Log a Single Entry command causes logging to start, collect one single entry, and immediately
stop again. This function is not available when logging is already running.

Click Clear Log to discard any previously collected data. If there is data in memory, which has not
been saved to disk, this function displays a prompt asking to verify it is OK to discard the data. If the
log is active when this function executes, the log continues running after the existing data is discarded.

Click Save Log to save the collected log data to a csv file. This stops the logging function, if it is
active, and displays a file dialog box to specify where to store the logged data. The Log Status and
Control Information section below describes the default file name, but you may change the file name if
desired.

4.2.3 Help Menu

The Help menu contains a single function: About.

Figure 6:
Help Menu

Help

About

The About function displays a dialog box (Figure 7) showing the version and copyright information for
the application and library. Click the OK button to close this window and continue.
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Figure 7:
About Window

About TMD3719 X

TMD3719
Version 1.0.0.0
Copyright © ams AG

888 S0t
L bbb -

GUIfor TMD3719 ~

This program is provided AS IS with NO
WARRANTY OF ANY KIND, INCLUDING THE

WARRANTY OF DESIGN, MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE.

System Level Controls

At the most left side of the main window is the system level controls for the system level functions of
the TMD3719 device.

Enable Group Box
The Enable group box consists the following check boxes:

The Power On checkbox controls the PON function of the TMD3719. When this box is checked, the
power is on and the device can operate. When this box is unchecked, the power is off and the device
does not operate (You can still change the control registers, but the device does not perform ALS and
Prox functions).

The ALS Enable checkbox controls the AEN function of the TMD3719. When this box is checked, the
device collects and report ALS data as programmed. When this box is unchecked, the ALS function
does not operate.

The Prox Enable checkbox controls the PEN function of the TMD3719. Proximity detection is enabled
when this box is checked or disabled when unchecked.

The Flicker Enable checkbox controls the FEN function of the TMD3719. Flicker detection is enabled
when this box is checked or disabled when unchecked.
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4.3.2 Modes Group Box

Modes group box has one check box Use VSYNC. When checked, the classical ALS, prox and flicker
detection will start with next VSYNC instead of immediately.

4.3.3 Osc Group Box
Osc group box has Mode combo box and VSYNCH numeric box.

Mode has 3 options: disable, once, and always. It controls how often the internal oscillator is
synchronized with the input VSYNCH signal.

VSYNCH sets up VSYNC frequency expected by the device. It controls VSYNC_FREQ function of
TMD3719.

4.4 Auto Polling

The application automatically polls the TMD3719 raw data of ALS, Prox and Flicker if enabled. The
Poll Interval displays the time between reads of the device.

4.5 Device ID Information

The lower left corner of the window displays the ID number of the EVM Controller board, identifies the
device being used and displays the ID of the device.

4.6 Log Status and Control Information
The lower right corner of the window contains status information and controls for the logging function:

Figure 8:
Logging Status

I |
Court Hapsed Time  [32000 iy
0 0

This section contains text boxes that are stored in the log file data and used to build the file name for
the log file. If the data in these fields are changed, the new values are stored with any new data
logged. The default file name is based on these values at the time the log file is written. If nothing is
entered in these boxes they default to a period (“.”).

Sample default file name:
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TMD3719_1-2-3 Log HH_MM_SS.csv

From Application

From User Input
The Count value displayed is a count of the number of samples currently in the log buffer.
The Elapsed Time value indicates the elapsed time since data logging started.

The numeric box in the bottom right-hand corner sets a limit to the size of the collected dataset. You
may select a value from the pull-down list, or enter a value manually. When the number of entries in
the log reaches this value, the program will automatically stop logging and display a file dialog box to
specify where to store the logged data. You may change the file name if desired. The maximum value
that may be entered in this field is 32000.

4.7 “ALS” Tab

The main portion of the screen contains a tab labeled ALS. The controls in this tab are divided into 3
sections, each performing a separate function.

Figure 9:
ALS Tab
ALS Prox  Flicker
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] Common Clear 0: 5472 5480 4
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4.7.1 ALS Controls

The left side of the ALS tab contains controls to set various ALS settings.

The Gain group box has controls to set up AGC and gain value for each channel. The most left AGC
check boxes enable AGC function for each channel when checked. The combo boxes AGAIN setup
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GAIN values for each channel. When the Common check box checked, it will use the setups of the
channel O for all rest of the channels.

The ATIME and the ASTEP sets the time of the ALS integration. ALS integration time = (atime+1)
*(astep+1) * modclk, where modclk = 2.7126736 ps.

The AGAIN control is a pulldown menu which sets the analog gain of the ALS sensor. The values
available are 2x, 4x, 8x, 16x, 32X, 64x, 128x, 256x, 512x, 1024x, 2048x, and 4096x when AGC is not
enable, and 128x, and 4096x when AGC is enabled.

The WTIME control sets how many WSTEP time to wait between ALS measurement sequencer steps.

The WSTEP control selects Modulator trigger timing step. It defines the repeat rate of ALS
measurement. The values are “off’, 2.78ms, 50ms, 86.81us, 1.5625ms, and VSYNC.

4.7.2 ALS Output Data

The top right corner of the ALS tab displays the output data. This data is continuously read. The
polling interval is shown above the tab.

Clear 0: displays the Channel 0 clear data count.
Red 1: displays the Channel 1 red data count.

Green 2: displays the Channel 2 green data count.
Blue 3: displays the Channel 3 blue data count.

Leak 4: displays the Channel 4 leakage data count.
Wide 5: displays the Channel 5 wideband data count.

4.7.3 ALS Data Plot

The remaining portion of the ALS tab is used to display a running plot of the collected ALS values. The
last 350 values are collected and plotted on the graph. As additional values are added, the old values
will be deleted from the left side of the graph. To start the plotting function, check the Enable Plot
checkbox and select the 0, 1, 2, 3, 4, and 5 checkboxes.
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Figure 10:
ALS Data Plot

] Enable Plot | Clear Plot
R Mo M1 M2 M3 M4 M

The scale of the Y-axis of the plot can be adjusted by clicking on the small up and down arrows at the
top left corner of the plot. The scale can be set to any power of 2 from 64 through 65536.

Click the Clear Plot button to discard the current data and continue plotting the new data. Note if the

Clear Plot button is clicked while the plot is disabled, the data is discarded, but the actual plot will not
be updated until the plot function is re-enabled.

4.8 “Prox” Tab

The main portion of the screen contains a tab labeled Prox. The controls in this tab are divided into 3
sections, each performing a separate function.
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Figure 11 :
Prox Tab
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Prox Controls
The left side of the Prox tab contains controls to set various Prox settings.

The PPULSE controls the number of pulses used for each prox cycle. The number of pulses is one
more than the PPULSE value and is displayed immediately to the right of the box. The pulse count
can be set between 1 and 256 pulses.

The PPULSE_LEN control sets the width of all IR LED pulses within the proximity cycle. Longer
pulses result in increased proximity range and typically result in less electrical noise generated in the
analog front end. Pulse Length can be set to any power of two, from 4 us to 512 ps.

The PGAINO and PGAINL1 controls is are pulldown combo box that lets you control the two gain
stages of the proximity IR sensor. The PGAINO values are 1x, 2x, 4x and 8x. The PGAIN1 values are
1x, 2%, 4x and 8x.

The PSTEP control selects the timing of the timing steps that define the repeat rate of proximity
measurements. The PSTEP values are “Always”, 2.8 ms, 50 ms, 86.81 us, 1.5625 ms, and VSYNC.
The term “Always” implies that the proximity measurement is always triggered, meaning that the next
measurement begins immediately. VSYNC uses the VSYNC input for each trigger step.

The PTIME control sets the repeat rate of proximity measurements by selecting how many PSTEPs
occur between the start of each measurement. Note that the actual number of steps taken is PSTEP +
1.

The SYNCH DELAY control sets the delay of the synch input in multiples of the modulator clocks
(2.7126736 ps).
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The CURRENT SINK group of controls sets the current used by each of the IR VCSELs

° The Detect and Release controls the scaler values used when the device is in Detect or
Release mode. These modes are defined by the setting of the Limits controls. Each of these
controls can be set to 0.5 mA, 1.0 mA, 1.5 mA, or 2.0 mA.

° The 0, 1, and 2 controls set the actual sink current for VCSEL 0, 1, and 2 respectively, in
multiples of the Detect and Release step size. Sink 0 is the Master VCSEL. The current for this
VCSEL is the value in the 0 control + 1 times the Detect/Release step. For VCSELs 1 and 2,
the sink current is the value in the associated control times the Detect/Release step. This
means that the Master VCSEL current sink cannot be set to 0 mA, but that the other two can).

° The actual sink current for each of the VCSELSs in each of the modes is shown directly to the
right of each VCSEL control and below the Detect and Release controls.

The Burst Delay controls the delay of 2 sets of proximity pulses when the VSYNC signal is being
used to trigger proximity measurement. Units are specified as 1/256" of the VSYNC period.

The Prox Average control sets how many ADC samples averaged for the proximity values. The
control can be set to “Off” orto 2, 3, 4, 5, 6, 7, or 8 samples. The prox data will be updated every cycle
with a running average of the last N samples.

The Pre-Filter checkbox causes the prox data to be a sum of two consecutive prox measurements.
When selected, the sum of the two samples is used for pdata and interrupt generation. This also
affects the Prox Average function.

The POFFSETO/1 controls shift PDATAO/1 to remove crosstalk from the proximity data. The values
range from -255 to 255. This value can be set manually, or it can be set by the Proximity offset
calibration.

The Calibrate button triggers the sensor’s proximity offset calibration sequence. This function
automatically selects a POFFSET to remove crosstalk from PDATA.

The Auto Offset Adjust checkbox enables a function that automatically decrements the POFFSET
value any time the PDATA value is 0. When this function is active, manual changes to the POFFSET
control are disabled, and the program will read and update the POFFSET value each time it reads the
PDATA value.

The APC Off checkbox disables the Automatic Pulse Control function. This feature is used for
hardware configurations with high crosstalk.

The Limits group box has controls to set up threshold values as following.

° N Low/F Low/R Low is near/far/ratio proximity ADC channel low threshold to generate
interrupt. The value range is from 0 to 65535.

° N High/F High/R High is near/far/ration proximity ADC channel high threshold to generate
interrupt. The value range is from 0 to 65535.

° AND check boxes set the relative threshold data to be seen as AND for pint calculation if
checked, or set the relative threshold data to be seen as OR if not checked.
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Exceeding the high values of the limit conditions causes the system to be in Detect mode. Falling
below the low values of the limit conditions causes the system to be in Release mode.

4.8.2 Prox Output Data

The top right corner of the Prox tab displays the output data. This data is continuously read. The
polling interval is shown above the tab.

° PDATA N/PDATA F/PDATA R displays the data counts of the Proximity ADC channels of
Near/Far/Ratio. The displayed ratio, calculated by the TMD3719 device is 128 times Near/Far.
The GUI adds an additional line, PDATA R*, which displays this value divided by 128 as a
floating-point value.

° Mean displays the calculated average of the last 32 PDATA samples displayed on the screen.
° StDev displays the calculated standard deviation of the last 32 PDATA samples displayed on
the screen.

4.8.3 Prox Data Plot

The remaining portion of the Prox tab is used to display a running plot of the collected PDATA values.
The last 350 values are collected and plotted on the graph. As additional values are added, the old
values will be deleted from the left side of the graph. To start the plotting function, check the Enable
Plot checkbox.

Figure 12:
Prox Data Plot

Enable Plat Clear Plot
Mear Far ] Ratio

% 2048

Pi W]

|l
i

The scale of the Y-axis of the plot can be adjusted by clicking on the small up and down arrows at the
top left corner of the plot. The scale can be set to any power of 2 from 16 to 16384.
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Click the Clear Plot button to discard the current data and continue plotting the new data. Note if the
Clear Plot button is clicked while the plot is disabled, the data is discarded, but the actual plot will not
be updated until the plot function is re-enabled.

4.9 “Flicker” Tab

The main portion of the screen contains a tab labeled Flicker, which configures the settings for flicker
detection and display the results of the flicker detection.

Figure 13:
Flicker Tab

ALS  Prox  Flicker

Disable Flicker before changing controls Bf” 0 0
Bin 1 0
Collection Time: 50ms ~ Bin 2 0 SCALE
Bin 3 0 0
Num Samples: 128 PW_DC 0
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Bin 0: |11 240 Hz

A A e ] e

Bin 1: |0 20Hz
Bin 2: |0 20Hz
Bin 3: |0 20Hz

49.1 Flicker Controls

The controls on this tab may only be changed when the Flicker Enable checkbox is unchecked. When
Flicker Detection is running, these controls may not be changed.

The Collection Time control sets the total time to measure flicker. It has 4 values of 50ms, 100ms,
200ms and User defined. When one of the numeric values is chosen, the Num Samples and Sample
Time controls are locked and set to pre-defined values. When “User” is selected the user may change
those controls.

The Num Samples control sets the number of samples used to measure for flicker detection. It can be
set to values of 128, 256, 512, or 1024.

The Sample Time control sets the sample frequency of the Flicker data collection. The overall
collection time for each flicker detection is (Num Samples) * (Sample Time + 1) * modclk.

The Bin 0/1/2/3 controls specify the bin number for up to four frequencies to check for Flicker. The
size of each bin is determined by the sample frequency and number of samples collected. The actual
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frequency is displayed immediately to the right of each control. The values entered for each of these
controls can range from 0 to 31.

On the right-hand column, Bin 0/1/2/3 values display the amount of energy detected at each of the
selected frequency bins. The actual values are scaled by a value of two raised to the SCALE value
displayed to the right of these values.

The PW_DC is the DC power of the light received.

The PW_TOT is the total power of the light received.
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5 Resources

For additional information regarding the TMD3719, please refer to the datasheet. For information
regarding the installation of the TMD3719 EVM host application software please refer to the TMD3719
EVM Quick Start Guide.

Designer’s Notebooks dealing with various aspects of optical measurement and optical measurement
applications are available. All content is available on the ams website www.ams.com.

@ For further information, please refer to the following documents:

° TMD3719 Datasheet

° TMD3719 EVM Quick Start Guide (QSG)

° TMD3719 EVM User’s Guide (this document)
° TMD3719 EVM Schematic Layout
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5) Revision Information

Changes from previous version to current revision v1-00

Initial Release

° Page and figure numbers for the previous version may differ from page and figure numbers in the current revision.
° Correction of typographical errors is not explicitly mentioned.
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7 Legal Information

Copyrights & Disclaimer

Copyright ams AG, Tobelbader Strasse 30, 8141 Premstaetten, Austria-Europe. Trademarks Registered. All rights reserved.
The material herein may not be reproduced, adapted, merged, translated, stored, or used without the prior written consent of the
copyright owner.

Demo Kits, Evaluation Kits and Reference Designs are provided to recipient on an “as is” basis for demonstration and
evaluation purposes only and are not considered to be finished end-products intended and fit for general consumer use,
commercial applications and applications with special requirements such as but not limited to medical equipment or automotive
applications. Demo Kits, Evaluation Kits and Reference Designs have not been tested for compliance with electromagnetic
compatibility (EMC) standards and directives, unless otherwise specified. Demo Kits, Evaluation Kits and Reference Designs
shall be used by qualified personnel only.

ams AG reserves the right to change functionality and price of Demo Kits, Evaluation Kits and Reference Designs at any time
and without notice.

Any express or implied warranties, including, but not limited to the implied warranties of merchantability and fitness for a
particular purpose are disclaimed. Any claims and demands and any direct, indirect, incidental, special, exemplary or
consequential damages arising from the inadequacy of the provided Demo Kits, Evaluation Kits and Reference Designs or
incurred losses of any kind (e.g. loss of use, data or profits or business interruption however caused) as a consequence of their
use are excluded.

ams AG shall not be liable to recipient or any third party for any damages, including but not limited to personal injury, property
damage, loss of profits, loss of use, interruption of business or indirect, special, incidental or consequential damages, of any
kind, in connection with or arising out of the furnishing, performance or use of the technical data herein. No obligation or liability
to recipient or any third party shall arise or flow out of ams AG rendering of technical or other services.

RoHS Compliant & ams Green Statement

ROHS Compliant: The term RoHS compliant means that ams AG products fully comply with current RoHS directives. Our
semiconductor products do not contain any chemicals for all 6 substance categories plus additional 4 substance categories (per
amendment EU 2015/863), including the requirement that lead not exceed 0.1% by weight in homogeneous materials. Where
designed to be soldered at high temperatures, RoHS compliant products are suitable for use in specified lead-free processes.

ams Green (RoHS compliant and no Sb/Br/Cl): ams Green defines that in addition to RoHS compliance, our products are free
of Bromine (Br) and Antimony (Sb) based flame retardants (Br or Sb do not exceed 0.1% by weight in homogeneous material)
and do not contain Chlorine (Cl not exceed 0.1% by weight in homogeneous material).

Important Information: The information provided in this statement represents ams AG knowledge and belief as of the date that
it is provided. ams AG bases its knowledge and belief on information provided by third parties, and makes no representation or
warranty as to the accuracy of such information. Efforts are underway to better integrate information from third parties. ams AG
has taken and continues to take reasonable steps to provide representative and accurate information but may not have
conducted destructive testing or chemical analysis on incoming materials and chemicals. ams AG and ams AG suppliers
consider certain information to be proprietary, and thus CAS numbers and other limited information may not be available for

release.

Headquarters Please visit our website at www.ams.com

ams AG Buy our products or get free samples online at www.ams.com/Products
Tobelbader Strasse 30 Technical Support is available at www.ams.com/Technical-Support

8141 Premstaetten Provide feedback about this document at www.ams.com/Document-Feedback
Austria, Europe For sales offices, distributors and representatives go to www.ams.com/Contact
Tel: +43 (0) 3136 500 0 For further information and requests, e-mail us at ams_sales@ams.com
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